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Guide Overview

This product guide is intended to provide functional, operational and 
installation information for Koheras BOOSTIK LC laser amplifiers. 

WARNING: Do not operate the laser before first reading and understanding all
warnings, cautions and handling information stated within the document:

Koheras BOOSTIK LC-series Laser Safety, Handling and Regulatory Informa-
tion

WARNING: Use of controls or adjustments or performance of procedures other
than those specified herein may result in hazardous radiation exposure.

Documentation A USB memory stick is included. It contains the soft copy documentation for 
this laser.

Terminology The guide may refer to both the Koheras BOOSTIK LC as the laser amplifier or 
just simply module. The Koheras BOOSTIK LC is a module designed to be fitted 
to and as part of a complete laser system.

Target Audience This guide is for technical personnel involved in the selection, planning and 
deployment of lasers in laboratory and industrial settings. The guide assumes a 
reasonable knowledge level of lasers, photonic principles and electrical 
interface connectivity. 
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Chapters Inside This guide includes the following chapters:

• Chapter I “Description” — Describes the Koheras BOOSTIK LC laser 
amplifier module including its general operational description and features, 
interfaces.

• Chapter 2 “Installation” — Includes information and procedures on how to 
correctly install the module. Procedures within this chapter focus on 
providing adequate temperature regulation. 

• Chapter 3 “CONTROL GUI” — Introduces and describes how to use the 
software control interface software to manage the module.

• Chapter 4 “SDK Registers and Tabs” — An introduction to the registers and 
tabs of the Generic User Interface included with the NKT Photonics 
Software Development Kit.

• Appendices — The guide includes multiple appendices including 
specifications, support contact details, connector pin assignments, error 
codes and a control software installation procedure. 
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Added information
and Safety Notices

Lasers are highly dangerous devices that can cause serious injury and property 
damage. This guide use the following symbols to either highlight important 
safety information or provide further information in relation to a specific topic.

NOTE: Highlights additional information related to the associated topic and/or
provides links or the name of the NKTP guides describing the additional infor-
mation.

CAUTION: Alerts you to a potential hazard that could cause loss of data, or dam-
age the system or equipment.

WARNING: The laser safety warning alerts you to potential serious injury that
may be caused when using the laser.

Revision This section records the document revision history.

Release date Version and changes

2021-September 1st revision

2021-October Revision 1.1

Added the following:
•  “CONTROL settings” on page 36 - added 

Power/Current mode setting item in the table.
•  “Power/current mode” on page 36
•  “Current mode” on page 44
•  Error codes 65 and 65 to Table 14 on page 63

Updated the following:
•  Figure 38 on page 54 - added Bit 8 - Input 

power low.

2022-March Revision 1.2
•  Minor changes to language throughout to 

improve clarity.
•  Changed figure arrows and other figure 

highlights throughout.
•  Updated Procedure 4 on page 65 to Windows 

10 format.

2023-March Revision 1.3
•  Edited the incorrect caption of Figure 4 on 

page 20.
•  Fixed the broken link in the note under ““Rear 

panel” on page 20.
•  Fixed the broken link in section “Errors” on 

page 54.
•  Updated minor grammar and other link issues 

throughout.
•  Updated NKT Photonics website addresses.
•  Updated some of the pagination in chapter 

““SDK Registers and Tabs” on page 49”.
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2023-October Revision 1.4
•  Updated the style of the document.
•  Updated images with the latest chassis and 

faceplate markings.

Release date Version and changes
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 1   Description

The Koheras BOOSTIK LC is a compact fiber amplifier module for low-noise, 
narrow-linewidth Koheras seed lasers. The module is designed as a line card 
component of a complete laser system. The module inserts into a Koheras 
ACOUSTIK 16-slot rack shelf where it occupies two slots. 

The ACOUSTIK shelf provides power and communications to the BOOSTIK LC 
module and it also houses a seed laser such as a Koheras BASIK. The optical 
output fiber of a Koheras BASIK seed laser connects to the optical input of a 
BOOSTIK LC module where the light is amplified before exiting from its optical 
output fiber and finally the standard FC/APC connector.

The amplifier module operates in the 1060-1075 nm or 1545-1565 nm 
wavelength range. Depending on the variant, the amplifier is designed to 
extend the output power of its seed laser to either 200 mW or 2 W output 
power. The amplifier achieves this while preserving the seed laser’s ultra-low 
noise and narrow linewidth optical output. 

The rear panel of a BOOSTIK LC module includes an electrical connector. The 
connector is designed to interconnect with an ACOUSTIK backplane connector 
when the module is inserted into the shelf. Using NKT Photonics CONTROL 
software, all inserted modules in the shelf are controlled from a single 
ACOUSTIK software interface through either USB or Ethernet connectivity.

Figure 1  BOOSTIK LC general view

NOTE: You can also implement BOOSTIK LC modules as components in a cus-
tom laser system. For these applications, an SDK is available to integrate the
module with the system control platform.
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Front and rear panels
Variants Three different BOOSTIK LC variants are available and mainly characterized by 
their output power and center wavelength. You can compare their 
characteristics in Table 1 below. 

Table 1  BOOSTIK LC variants and their characteristics

Front and rear panels

Front panel The front panel shown in Figure 2 is typically fitted with a Koheras ACOUSTIK 
faceplate and includes: an Output fiber and connector, an Input fiber 
connector, and status LEDs. Note that the output fiber and connector is fitted at 
the factory. 

The status LEDs on the front panel indicate the following states:

• Power – the supply voltage status

• Interlock – interlock circuit open/closed (not OK/OK)

• Emission – the laser emission status (enabled or disabled)

• Status – the module stability status

Variant: 2 W@ 1550 nm 200 mW@1550 nm 200 mW@1064 nm

Compatible Koheras seed laser(s) E15, X15,C5 E15, X15,C5 Y10

Operation mode CWi

i. Continuous Wave - inherently single frequency

CWi CWi

Operating wavelength [nm] 1545 to 1565 1545 to 1565 1060 to 1075

Input power [mW] 1 to 50 10 to 50 10 to 50

Output power [mW] 2000 200 200

Output power tunability [%] 10 to 100 10 to 100 10 to 100

Polarization PMii or SMiii

ii. Polarization Maintaining
iii. Singe Mode

PMii PMii

Input and output optical 
termination

FC/APCiv

iv. E2000 optional

FC/APCiv FC/APCiv

Output fiber type PM1550 or SMF28 PM1150 PM980

2
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Front and rear panels
For more information see “Status LEDs” on page 22.

Figure 2  BOOSTIK LC front panel layout

Koheras ACOUSTIK faceplate
A faceplate is mounted onto the front panel of the module casing and has four 
screw holes that align with the mounting holes of the ACOUSTIK slots. Once 
inserted into the ACOUSTIK, the module is fastened using four M4x0.7 screws.

Figure 3  Inserting a BOOSTIK LC into an ACOUSTIK shelf

1 Koheras ACOUSTIK faceplate 4 Output fiber and connector

2 Status LEDs 5 Handle

3 Input fiber connector

4 5

1 2 3

23

1 2

 4x M4x0.7 
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Front and rear panels
Input fiber connector
A threaded E2000 input connector. The connector is designed to received the 
seed optical signal from a BASIK module.

Output fiber and connector
Optical output fibers and connectors are specified in Table 1.

Handle
Grip the handle firmly, when inserting and removing the BOOSTIK LC from a 
slot in the ACOUSTIK shelf.

Rear panel The rear panel, shown in Figure 4, includes: the main electrical interface, 
alignment holes, a heat transfer surface and three M4 tapped holes for 
fastening the laser from the rear.

Figure 4  BOOSTIK rear panel layout

Main electrical Interface
The main electrical interface is a 30-pin male C/3 connector located on the rear 
panel of the module. The interface includes pins for the following signals:

• Serial communication – RS-485

• Interlock

• Emission control

• Modulation input/output – wavelength modulation

NOTE: For a complete description of the pin assignments, see “Electrical inter-
face pinout” on page 61.

1 Main electrical interface – C3 3 Alignment holes

2 M4 mounting screw holes

23

1 2
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Front and rear panels
 CONTROL GUI You can manage a BOOSTIK LC laser amplifier and all other modules inserted 
into an ACOUSTIK shelf using NKT Photonics CONTROL graphical user interface 
(GUI) software installed on a PC. The PC is connected to an ACOUSTIK through 
either a USB or Ethernet connection.

To connect to and access a BOOSTIK LC module, follow the procedures to 
connect CONTROL to the ACOUSTIK shelf described in the document:

Koheras ACOUSTIK Product Guide

Once connected, use the software to control and monitor the amplifier emission. 
You can also view the amplifiers status and error state. For more information, 
refer to the chapter: “CONTROL GUI” on page 31.

Generic UI and NKT
Photonics SDK

The Generic User Interface or Generic UI is control interface software intended 
for setting and monitoring the BOOSTIK LC registers. Registers are set or 
monitored through the Interbus protocol of the NKT Photonics SDK. 

The SDK and Generic UI are intended for integration of the laser with a custom-
built control system. The Generic UI platform provides a convenient interface 
useful during development and deployment. Instructions on how to use the 
Generic UI and Interbus protocol can be found in the SDK user manual included 
with the kit. 

For BOOSTIK LC error codes and status bits, see Appendix D.

Enabling emission The BOOSTIK LC is intended for use as a component in an ACOUSTIK shelf as 
part of a complete laser system. To enable emission from the module, refer to the 
procedures in the document:

Koheras ACOUSTIK Product Guide
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Status LEDs
Status LEDs

The rear panel houses four status LEDs that behave as described in Table 2. 
The LEDs are located on the center top of the front panel as shown in Figure 5.

Figure 5  Status LEDs

Table 2  Status LEDs

NOTE: DO NOT OPERATE the laser until you are familiar with the controls and
have taken all precautions necessary as described in the Koheras BOOSTIK
LC-series Laser Safety, Handling and Regulatory Information.

Power Status

Interlock Emission

Power Status

Interlock Emission

LED Name Condition Description

Power ON Green DC Voltage at the DC power input pins is OK.

ON Red DC voltage at the DC power input pins is too 
low.

Flashing Amber The module is transmitting data.

OFF No DC power at the module power input pins.

Emission ON Red Laser amplifier emission is ON. 

OFF Laser amplifier emission is OFF.

Status ON Green Output power OK

ON Amber Module ready

Interlock ON Green The interlock status is OK – the door circuit is 
closed and energized.

ON Red The interlock status is Not OK – the door circuit 
is open or not energized.
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Chassis labels
Chassis labels

BOOSTIK LC labels The Koheras BOOSTIK LC chassis includes multiple labels that indicate hazards, 
regulatory and manufacturing information. The labels are described in Table 3 
and their location is shown in Figure 6.

Table 3  BOOSTIK LC Chassis labels

Label Description 2 W 200 mW

Laser 
component 
designation

Statement indicating the device 
is a component of a laser system.

Classification 
emission 
hazards

Safety information stating the 
laser emission hazards and the 
amplifier’s laser class rating.

Product 
information

Safety label showing the 
emission specifications the 
amplifier is capable of.

Laser 
Radiation 
Warning

Safety information alert 
indicating this area of the laser is 
near a source of dangerous laser 
emission. 

Manufacturing Manufacturing information 
including address, part and serial 
number, and date manufactured.

Warranty The module is sealed with this 
label. It is prohibited to remove 
the chassis cover.

DESIGNATED FOR USE SOLELY AS A COMPONENT, 
AND DOES NOT COMPLY WITH IEC  60825-1 OR 
21 CFR 1040.10 AS A COMPLETE LASER PRODUCT

WARNING - INVISIBLE LASER RADIATION
AVOID EXPOSURE TO BEAM
CLASS 4 LASER COMPONENT

WARNING - INVISIBLE LASER RADIATION
AVOID EXPOSURE TO BEAM
CLASS 3A LASER COMPONENT

MAXIMUM OUTPUT POWER: 5W
WAVELENGTH: 900 - 2100 nm

MAXIMUM OUTPUT POWER: 500 mW
WAVELENGTH: 900 - 2100 nm

WARRANTY VOID IF SEAL
IS BROKEN OR REMOVED
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Chassis labels
Figure 6  Top panel label locations

1. Product identification 4. Laser radiation warning
2. Warranty 5. Laser component designation 
3. Product information 6. Classification emission hazards

WARNING - INVISIBLE LASER RADIATION
AVOID EXPOSURE TO BEAM
CLASS 4 LASER COMPONENT

MAXIMUM OUTPUT POWER: 5W
WAVELENGTH: 900 - 2100 nm

DESIGNATED FOR USE SOLELY AS A COMPONENT, 
AND DOES NOT COMPLY WITH IEC 60825-1 OR 
21 CFR 1040.10 AS A COMPLETE LASER PRODUCT

WARRANTY VOID IF SEAL
IS BROKEN OR REMOVED

4 5

1

6

2 3
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 2   Installation

Safety

WARNING: A Koheras BOOSTIK LC is a Class 4 laser and exposure to its emission
is hazardous. Follow all regional laser safety regulations regarding installation,
operation, and otherwise. Ensure to verify with your Laser Safety Officer (LSO)
that the installation follows all applicable safety regulations and do no operate
the laser until the officer approves it.

Passive cooling

A BOOSTIK LC module generates a substantial amount of heat that must be 
dissipated. The module uses a passive cooling design to dissipate the heat. To 
facilitate passive cooling, ensure either the rear or left panel is in firm contact 
with a heat conductive material that has an efficient thermal path.

CAUTION: For reliable operation, do not expose the BOOSTIK LC to corrosive
agents or excessive moisture, heat or dust.

CAUTION: Table 11 in Appendix A lists the specifications for the BOOSTIK LC op-
erating environment.

Rear panel The rear panel surface shown in Figure 7 acts as passive heat conductor for the 
module. Using this surface, mount the module so that the surface is in contact 
with a heat conductive material and path to for example, cooling fins. When the 
module is inserted into an ACOUSTIK shelf, the rear panel surface is firmly 
pressed against special conductive metal foil lining the rear backplane of the 
shelf. This facilitates heat transfer to the cooling fins mounted on the rear of the 
ACOUSTIK.

Figure 7  Rear panel heat conduction surface s

CAUTION: For proper operation and to prevent equipment damage, do not in-
sert and operate more than two Koheras BOOSTIK LC modules inserted into
specific slots of a Koheras ACOUSTIK shelf. Ensure to follow all installation in-
structions noted in the Koheras ACOUSTIK Product Guide. 
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Custom mounting
Left side panel
surface

You can optionally mount the left side panel surface, shown in Figure 8 below, 
in contact with a heat conductive material and preferably a heat sink. Five 
M3x0.5 screw holes are available to firmly mount the module for proper heat 
conduction. 

Figure 8  Left side panel heat conduction surface s

Example side panel cooling
Figure 9 shows a custom passive cooling block mounted on the left panel. The 
block is custom built and illustrated as an example only. NKT Photonics only 
supplies cooling fins included on the rear of an Koheras ACOUSTIK shelf.

Figure 9  Custom passive cooling block mounted on the left panel

Custom mounting

As an example, for a simple custom system, you can place the BOOSTIK LC 
module on a level and stable surface. Bolt the module for example, to a table 
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Custom mounting
using a custom mounting bracket (not included) attached to the side of the 
module as shown in Figure 10.

Figure 10  Example custom mount installation

Custom installation
rules

• Allow for proper ventilation and cable access.

• Do not store or place anything on the top panel of the amplifier.

• Ensure the ambient operating temperature and humidity is stable as stated in 
the Table 11 on page 57.

• Avoid placing the amplifier near sources that could cause temperature 
fluctuations.

• The surface the amplifier is placed on, must be free of vibration or 
mechanical shocks.

• Always provide a thermal cooling path from either the rear or side panel.

• Do not bend the fibers below a bend radius of 10 cm.

• The amplifier is a Class 4 laser and as such the installation area must follow 
all regional laser safety regulations as defined by the assigned Laser Safety 
Officer (LSO). 

   M6 bolt   M6 bolt

   M6 bolt   M6 bolt
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Interlock
Interlock

The BOOSTIK LC includes a safety Interlock function. The function shuts down 
the emission immediately when a circuit loop connected to pins A3 and A4 is 
either opened or shorted to ground. 

When inserted into an ACOUSTIK shelf, the interlock circuit loop is connected 
through all installed modules and an external door switch circuit to protect the 
operating enclosure. For more information regarding the Interlock and how to 
connect a door safety switch, refer to the Koheras ACOUSTIK Product Guide.

Fiber tip cleaning

The output aperture of the BOOSTIK LC is a fiber with a optical connector. At 
the tip of the connector is a fiber facet where Class 4 emission are present. 
Without proper care the facet is easily contaminated or damaged affecting the 
output. 

To clean it, only use cleaning tools specifically designed for use with optical 
fibers. Always use extreme caution when cleaning fibers.

Examples of appropriate cleaning tools are:

Lens cleaning tissue (lint free wipes) see Figure 11

Optical fiber cleaning tool see Figure 12

Figure 11  Lens cleaning tissue - lint free

Figure 12  Optical fiber cleaning tool
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Polishing
Signs of damage Indications of a damaged fiber facet may be due to one of the following:

• Output power suddenly decreases.

• The spectrum (recorded from an optical spectrum analyzer) is significantly 
degraded compared to the original spectrum found in the measurement 
report.

• Light emitted from the fiber facet has a large color variation.

Emitted beam shape
When the fiber facet is clean and undamaged, the emitted beam has a 
discernible shape. An Incorrect beam profile occurs as a result of a damaged or 
dirty fiber facet. In this case, the emitted beam is random in direction and may 
even show variation in color.

Damaged facet If the fiber facet is damaged, you must re polish the connector before operating 
the laser. Failing to do so, could result in incorrect measurements/usage or even 
damage to the laser unit itself.

CAUTION: Do NOT remove the connector attached to the fiber, special equipment
and procedures are required to fit a new connector with the fiber.

Polishing

The end of the fiber is collapsed to a length of 150-200 microns. This allows 
enough length to polish the fiber end; however, be careful not to over-polish, 
generally NKTP recommends to return the unit for factory polishing. 

The general procedure is to:

1. Clean the connector and quickly and very lightly, polish the connector end.

CAUTION: Do not over-polish the connector end (fiber facet). Over-polishing the
connector end will damage it due to its limited length.

2. Clean the connector and then switch the source on. Observe the exit beam 
on a screen. If it is not a well-formed emission, repeat step 1.

3. Continue this "quick polish, check beam" process until a well-formed beam is 
obtained.

CAUTION: If you do not obtain a good beam profile after polishing, the connector
may be damaged. Return the laser to NKT Photonics for repair. Note that this
type of repair is not covered by warranty.
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Polishing
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 3   CONTROL GUI 

CONTROL GUI overview

The CONTROL window includes multiple panels and a selection of menu drop 
down items in the upper left corner. Using the top left drop-down menu, you 
can add or remove the displayed panels and panels can be dragged within the 
main window or into separate windows. The panels and menu shown in 
Figure 13 are briefly described Table 4 with links to more details descriptions.

Table 4  CONTROL panels and menu

Figure 13  CONTROL panels and menu

Panel Function See
Status panel Displays the selected device statuses, errors, 

module information, emission control and a 
CONTROL settings menu.

Status panel on page 34

Menu items Four drop down menus with multiple functions. CONTROL menu on page 37

Control Panel This panel provides configuration controls such 
as wavelength, pulse power and repetition rate.

Control panel on page 44

Application Log This panel displays a debugging log that can be 
saved to a file.

Application log on page 42

Device Monitor To also help debugging issues, this panel 
displays multiple port and device module 
parameters.

Device monitor on page 41

Module 
overview

Displays parameters and the status of modules 
inserted in an ACOUSTIK shelf where the 
BOOSTIK is inserted.

Refer to the Koheras 
ACOUSTIK Product Guide.

Quick Connect Click to connect to all devices available to 
CONTROL on serial and Ethernet connections.

Quick connect on page 33

Device 
Selector

A clickable icon tree for all connected devices. 
Click on the icon to access the device.

Device Selector on page 33

Device
selector

Quick
connect

Device monitor

Menu
items

Module overview

Control panel Status panel Application
log
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CONTROL GUI overview
Relocating panels You can drag the different panels of CONTROL to any location within the main 
interface or into a separate floating panel. Procedure 1 describes how to 
relocate a panel within the main window.

Procedure 1  Relocating panels 

Figure 14  Panel dragged to a new location in the main window 

Figure 15  Panels dragged outside the main window

Action

1 Left click and hold the top title bar of the panel.

2 While holding the left mouse button down, drag the panel to another location in the main 
window.

3 In the new location. when the background turns blue, release the mouse button – see 
Figure 14.

4 Alternatively, drag the panel out from the main window and release the mouse button. A 
separate window for the panel is created. (see Figure 15)

Left hold click
and drag the panel

Release the mouse
when the background
turns blue

Panels dragged outside
the main window
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CONTROL GUI overview
Toggling panels
visible

Use the Menu > Window drop down menu to check and uncheck panels to be 
displayed. A blue check mark indicates the panel is displayed.

Figure 16  Toggling panel visibility

NOTE: To close a panel, click the X at the upper right corner of the panel.

Connecting to the
laser

When CONTROL launches, the Welcome panel is displayed as in Figure 17. In the 
menu bar, click the ‘Connect’ drop down menu and then click on the COM or 
Ethernet port your ACOUSTIK shelf is using to connect CONTROL to the 
ACOUSTIK. The Control and Status panels are displayed when the laser 
connects to CONTROL.

NOTE: To connect the PC to CONTROL, refer to the document:

Koheras ACOUSTIK Product Guide

Figure 17  Welcome screen and connecting

Quick connect
Alternatively, click the quick connect button to scan the PC ports for compatible  
devices. CONTROL connects to any valid device connected to the PC.

Device Selector Left-click any BOOSTIK LC icon in the device selector to access its controls as 
shown in Figure 18. For an ACOUSTIK shelf, all inserted modules including any 
inserted BOOSTIK modules are shown as child modules of the ACOUSTIK.

Check the panels to
display them

Click
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Status panel
Figure 18  Device selector panel

Status panel

The Status Panel provides status indicators, error messages, system 
information, emission control function and a settings menu.

Figure 19  Status panel indicators

Status indicators The panel displays the following indicators:

BASIK seed laser

BOOSTIK LC selected

ACOUSTIK rackmount smart chassis

Click
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Status panel
Interlock
Indicates the state of the safety interlock circuit.

• ON Green – The interlock loop back circuit is closed i.e. connected.

• ON Red – The interlock loop back circuit is shorted to earth or open. For 
example, a connected door switch is open.

Status
Indicates the operational state of the laser.

• ON Red – An fault in the modules operation has occurred producing an error 
message in the status panel. Errors generated are listed below the Status 
indicator – see Appendix D  for a list of possible errors.

• ON Amber – The laser amplifier is ready.

• ON Green – The laser amplifier is operating normally and emission are 
enabled

Error messages Should a fault occur, an error message and its associated error code is displayed 
directly below the Status indicator. Error codes and their recovery actions are 
described in Table 14 on page 63.

System info The System Info section shows the following:

• Laser Serial Number

• Laser Firmware Revision

NOTE: System info is only displayed if the option is checked in the View menu - see
“View” on page 37.

Measurements The system temperature is displayed.

NOTE: Measurements are only displayed if the option is checked in the View menu
- see “View” on page 37.

Emission button The Emission button turns the laser amplifier emission ON. The button indicator 
is lit steady ON Red when any laser emission are generated. Otherwise, it is OFF 
Grey.

WARNING: Class 4 laser emission are emitted when the Emission button LED is ON
Red. 

NOTE: A BOOSTIK LC is a laser amplifier, as such its emission can only be enabled
when its connected seed laser emission is enabled. If you click the Emission but-
ton without a seed laser signal at the input , the action fails and raises error code
60.
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Status panel
CONTROL settings CONTROL settings are accessible by clicking the gear icon  in the upper 
right corner of the Status panel. Clicking the gear icon displays a drop-down 
menu of setting items as shown in Figure 20.

Figure 20  CONTROL settings

Power/current mode
Click the down arrow to access the mode selection drop-down menu on the 
right of the panel. 

Selecting “Power mode” sets the laser output power based on the power 
control setting and is kept stabilized using feedback from a sensor in the 
optical output.

Selecting “Current mode”, sets the output power to the level set using the 
power control slider in power mode. However, once in current mode, the 
power control setting is not available in the main Control panel and setpoint 
level of the output power is maintained by constant current fed to the amplifier.

Click the X in the upper right corner to close the panel and return to the main 
Control panel - see “Control panel” on page 44.

Figure 21  Power/current mode settings

Setting Item Function See

Power/current 
mode

When selected, the control panel allows 
you to set the amplifier to operate in either 
power or current mode.

Power/current mode on 
page 36

View Panel with check boxes to enable 
displaying the module Information and/or 
the system temperature on the status 
panel.

View on page 37

Click the gear icon
to access the menu 

 
 

Click to select
Power or Current mode
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CONTROL menu
View
Check the Module info box to display the laser serial number and firmware 
release number within the status panel.

Check the Measurements box to display the system temperature in the status 
panel.

In the User text: field, input an alphanumeric text string for the module. The string 
is displayed next to the module icon in the Device Selector.

Figure 22  View settings

CONTROL menu

There are four drop down menus in the main control window as highlighted in 
Figure 23. Click on the items in the menu to reveal the drop down menus.

Figure 23  Menu items

Check either box

 
 

User definable name

to display the items

– input field

Menu Item Function See

File Exits the CONTROL program

Connect / 
Disconnect

Connect – drop-down selection of pre-
configured device connections to connect 
control to.
Disconnects the currently connected device from 
CONTROL.

•  Refer to the included CONTROL user help 
under: Help-Show Instruction Manual.
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CONTROL menu
Key Updater tool The Key Updater tool is used to apply special features and corrections to 
modules and systems of the laser. 

To use the Key Updater tool follow Procedure 2.

Procedure 2  Using the Key Updater tool

NOTE: Certain keys generate a new locally generated key code. Locally gener-
ated keys are usually required during a support session and are emailed back
to the NKT Photonics support personnel.

Log downloader If your laser requires support from NKT Photonics, our support engineers may 
request that you send the log files collected by the laser. You can use the log 
downloader tool to save the laser log files to your CONTROL PC.

Tools Select from one of three special tools to use with 
your laser. Tools available are:

• Key Updater Tool
• Log Downloader
• Extensions Overview

•  Key Updater tool on page 38
•  Log downloader on page 38
•  Extensions overview on page 40

Window Selects whether or not to display the Application 
Log and/or the Device monitor.

•  Device monitor on page 41
•  Application log on page 42

Help Displays the current version of CONTROL and 
provides access to the included CONTROL user 
help.

Menu Item Function See

Action

1 Enter the key code in the field 
Enter key code.

2 In the list of modules, check the 
box on the right of each applicable 
module.

3 Click Apply 
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CONTROL menu
CONTROL automatically downloads log files from the modules of any connected 
devices. The log files are stored in a local database on the CONTROL PC. 
However, certain modules, including the Koheras BOOSTIK LC main board do 
not support automatic download of log files. For these modules. you can use the 
Log Downloader tool to put the device into dedicated log download mode by 
enabling a collect log function.

Fast log vs. slow log
Both fast and slow log types collect the same data from the device. The 
difference between the two logs is their polling resolution. A fast log polls for 
data at a far shorter interval then a slow log which is intended for device analysis 
over the life of the device. Since a fast log collects far more data over the same 
time, it appears to collect logs at a slower rate than a slow log, but this is only due 
to the large amount of data it collects in comparison.

NOTE: When the collect log function is enabled, it temporarily disables automatic
log collection from all other devices. The CONTROL interface turns grey (gray),
and communication with the laser and log collection with all other modules is dis-
abled

NOTE: Right clicking any device in the “Device monitor”, also displays log down-
load functions.

To download log files use the Log Downloader as described in Procedure 3.

Procedure 3  Using the Log Downloader

Action

1 Open the Tools menu and click on Log Download to start 
the Log Downloader tool.

2 The tool displays all connected 
modules with log capability. To 
decrease the download time of 
the module log files, CONTROL 
continuously collects module 
log data and stores this log 
data in a local database on the 
PC. The percentage indicator 
shows the amount of log data 
collected for each module. 
Logs are collected from each 
module. The total collected 
percentage is displayed for the 
module’s logs.

Connected
Modules

Percent
Collected
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CONTROL menu
Extensions overview You can use the Extensions Overview tool to view the installed extensions 
(plugins) that are included with CONTROL. The extensions are found in the 
following folder:

C:\Program Files (x86)\NKT Photonics\NKTP CONTROL\Plugins

3 To download and save a log 
file to the CONTROL PC, right 
click the percentage indicator 
and select either:

• Save log – Immediately 
saves the fast or slow log 
file onto the CONTROL 
PC. If the percentage 
shows less than 100%, the 
log is collected first. See 
Collect log below.

• Collect log – Starts a 
dedicated log collection 
mode that disabled all other
CONTROL activity.

4 If you select Save Fast or Slow 
log, a dialog box prompts for a 
filename and folder to store the 
log in.

5 If you select Collect Fast or 
Slow log, the log is collected 
and saved in dedicated mode. 
The CONTROL panel turns 
grey and all other functions are 
disabled.

When the log is finished being 
collected, all other CONTROL 
functions are enabled.

6 Select Restart Fast or Slow log 
to clear all the collected log 
data and restart the log data 
collection.

Action

Right click
the % indicator

Connected
Modules

Percent
Collected

Dedicated collection mode
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CONTROL menu
To view the extensions, open the Tools menu and click on Extensions Overview. 
The Extensions Overview window is launched as shown in Figure 24.

Figure 24  Extensions Overview

NOTE: To show a short description of the release notes as seen in Figure 24, hover
the mouse pointer over the Release notes text 

NOTE: Multiple extensions for a wide range of lasers types and accessories are
typically installed when using the default installation of CONTROL. 

Device monitor The device monitor provides a real-time display of communication port 
parameters and any connected device modules. 

The parameter values displayed are continuously updated and can be used to 
help debug issues with connected devices. The parameters are listed and 
described in Table 5. 

Table 5  Device Monitor parameters 

Parameter Description

Interface The PC port interface the device(s) is connected to. Click the greater 
than symbol to the left of the port to display the connected device (s) 
parameters.

TxTlgsSec The number of telegrams per second being transmitted to the 
connected device.

RxTlgsSec The number of telegrams per received from the connected device.

Addr The address of the connected module.

Type The type of the connected module read from the module.

SysType The system type, default 0 – can be used to describe system variants 
and is read from the module.

Name The name of the connected device module.

P/N The device module part number.

Mode The mode or status of the connected module: connected, 
disconnected, or disabled
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CONTROL menu
The panel is enabled by placing a check mark on the Window drop-down menu 
next to the Serial Monitor item.

To close the panel click on the upper right corner “X” or uncheck the item in 
the drop-down menu.

Application log In addition to the Serial Monitor, the Application Log panel is used for 
debugging serial communications. The panel displays time stamps for both 

Status bits The actual status bits read from the connected module.

Error code The actual error code read from the connected module.

Access Protected/Locked status of the module.

FW Ver. The device module’s firmware release date.

Module Serial The serial number of the device module

PCB Serial The device module’s printed circuit board serial number

PCB Ver, The version of the device module’s printed circuit board.

Sp. Cap/ The module speed capability in bits per second as read from the 
module – Values: 0=(default) 115200, 1=230400, 2=460800, 3=921600 

Pri Ext Primary extension/GUI loaded for this module. Hover over the icon to 
list more details – Note that there can only be 1 primary.

Fast Log 0%-100% collected. Note only if the module has a fast log and only 
internal modules have fast and slow logs.

Slow Log 0%-100% collected. Note only if the module has a slow log.

Mainboard Log 0%-100% collected. Note only if the module has a main log. Only main 
boards have a main and system logs.

System Log 0%-100% collected. Note only if the module has a system log. Only main 
boards have a main and system logs.

Timeout Time in milliseconds since the last telegram was received from the 
device module.

Nack Total number of negative acknowledgments received from the device 
module.

CRC Total number of received telegrams with CRC failures

COM Total number of communication errors with framing or protocol errors. 
Hover over the icon to list more details.

Busy Total number of busy responses from the module. Busy responses 
occur when the module receives a message but cannot process it due 
to its current work load.

Parameter Description
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CONTROL menu
COM port open and close times and also general status information. You can 
clear, save and print the log data using the buttons in the upper left corner.

Figure 25  Serial monitor

The panel is enabled by placing a check mark on the Window drop-down menu 
next to the Application Log item.

To close the panel click on the upper right corner “X” or uncheck it in the drop-
down menu.

Clear the log
Save the log to file
Print the log
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Control panel
Control panel

Power mode When set to Power mode within the Control Panel you can view both the 
measured input and output power, plus you can set the setpoint level of the 
output power. The laser amplifier measures the optical output power and uses 
the measurement to constantly adjust the level to the setpoint. 

Input
The Input field displays the optical power in milliwatts measured at the In (input) 
fiber port.

Output
The Output field displays the optical power in milliwatts measured at the Out 
(output) fiber port. This is the laser output aperture power and you can display 
the power level in either mW or dBm units by clicking the drop-down menu 
arrow. 

Power control
Set the output power setpoint level using the slider control. You can set the 
level can from 10 to 100% of the maximum rated power.

You can additionally key in the power level directly by using the text input field 
at the upper-right corner of the slider control. 

NOTE: Typically the maximum power exceeds the 100% rated value.

Figure 26  Power mode – viewing and setting optical power

Current mode When set to Current mode within the Control Panel you can view both the 
measured input and output power, but the Power control slider is removed. A 
constant current is fed to the laser amplifier to stabilize the output power. 
Before configuring the amplifier to operate in Current mode, the output power 
level must first be set in Power mode using the Power control slider.

Select either 
mW or dBm

Text input

Power setpoint
slider control

field
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Module overview
Input
The Input field displays the optical power in milliwatts measured at the In (input) 
fiber port.

Output
The Output field displays the optical power in milliwatts measured at the Out 
(output) fiber port. This is the laser output aperture power and you can display 
the power level in either mW or dBm units by clicking the drop-down menu 
arrow. 

Figure 27  Current mode – viewing optical power

Module overview

When CONTROL connects to a Koheras ACOUSTIK shelf, a Module overview 
panel is displayed beneath the Control and status panels. As shown in Figure 28, 
each row in the overview represents an inserted module and the column fields 
display the module parameters and statuses. Clicking on a row, selects the actual 
module and switches the view to the Control and status panels for the module.

Figure 28  Module overview - all fields selected 

Select 
mW or dBm
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Module overview
The following information is available from each of the available fields:

Table 6  Module overview fields

Toggling and sorting
the overview fields

In the module overview, you can sort the order of the fields and select the fields 
to display.

Setting the field order
With your mouse, click-hold on a field in the header and drag it to a new 
location to change the order of the fields in the header.

Togging fields on and off
Right-clicking on any of the fields in the header displays the menu shown in 
Figure 29. 

Column heading Description

Module Chassis slot number

Reference WL Base wavelength of the module in nm

Actual WL Output wavelength of the module in nm

WL offset Setpoint Wavelength offset set with CONTROL in pm

Actual WL offset Measured wavelength offset in pm.

Status Module status indicator

Power setpoint (mW) Power level set with CONTROL in mW

Actual power (mW) Measured power level in mW

Power setpoint (dBm) Power level set with CONTROL in dBm

Actual Power (dBm) Measured power level in dBm

Emission Displays status of module emission:

•  Red ON - emission enabled
•  OFF - emission disabled

Interlock Displays status of the interlock circuit:

•  Green ON - Interlock circuit closed
•  Red ON - Interlock circuit open or key switch 

off.

Error code Error code for an existing module fault - contact 
NKT Photonics support of the error persists.

Module Serial Factory serial number of the module.

FW. Ver. Firmware currently executing on the module.

Module Temp Temperature within the module.

User Text Text describing the module – see View on 
page 37.
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Module overview
To remove a field from the overview, click once on the any of the fields (except 
for Module) to uncheck it. Clicking once on an unchecked field, adds it back to 
the overview.

Figure 29  Module overview field selection

Click any field to remove it;
click it again to add it back 
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Module overview
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 4   SDK Registers and Tabs

NKT Photonics’ Software Development Kit (SDK) allows access to registers 
controlling the module’s operating parameters using its Generic User Interface 
(Generic UI). For general operation it is recommended to use CONTROL. This 
section’s purpose is to help introduce how to use the Generic User Interface to 
set some of the laser’s operating parameters. Table 7 presents the registers by 
their function with a link to a detailed description.

Table 7  Generic user interface registers

NOTE: This chapter introduces the Generic UI and its registers. For a full descrip-
tion of the SDK, registers and using the Generic User Interface, refer to the NKT
Photonics document: SDK Instruction Manual. The manual is installed when the
SDK installer is run.

SDK installer The SDK installer including instructions is available at the following URL:

https://www.nktphotonics.com/support

Read/write registers

To to set and operate the BOOSTIK LC, click on the Control tab in the left side 
half of the Generic UI window to view the read/write registers. For read/write 
registers not described in this document, refer to the SDK instruction manual 
included with the SDK installation.

Register name and link Function
Read/Write
Register

Read-only 
Register Unit

Output power setpoint 
on page 50

Sets the emission 
output power level.

22 & A0 – mW & dBm

Emission on page 50 Enables or disables 
emission

30 – –

Setup bits on page 51 Configures the 
operational mode,

31 – –

Stage one input monitor 
on page 52

Displays the optical 
input power received.

– 10 mW

Pump temperature on 
page 53

Displays the set pump 
temperature.

– 13 °C

Heat sink temperature 
on page 53

Displays the rear 
temperature sensor 
measurement.

– 1C °C

Errors and status 
indicators on page 54

Boolean status 
indicators and error 
codes displayed

– – –

Graphing on page 55 X-Y graphing of 
selected registers.

– – –
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Read/write registers
Figure 30  Read/write registers under the Control tab

Output power
setpoint

Input the setpoint power level of the optical output in mW or dBm. For setting 
the power using mW units, use register 22, and for using dBm units, used 
register A0.

Figure 31  Setting the output power setpoint

Emission Keying 1 into register 30 enables emission from the amplifier module. If there is 
no input power (“Stage one input monitor”), then enabling emission fails and a 

Readings

2
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Read/write registers
fault is raised with error code 60 displayed – see “Errors and status indicators” 
on page 54.

Figure 32  Enabling emission

Setup bits Register 31 Setup bits configures the laser amplifier to operate in either current or 
power mode. Set as follows;

• 0000 – Power mode

• 0001 – Current mode

Figure 33  Setting the setup bits
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Readings
Readings

To monitor the BOOSTIK LC, click on the Readings tab in the right side of the 
Generic UI window to view the contents of read-only registers. For read-only 
registers not described in this document, refer to the SDK instruction manual 
included with the SDK installation.

Figure 34  Read-only (monitor) registers under the Readings tab

Stage one input
monitor

Readings register 10 displays the input power in mW received at the optical 
input of the laser amplifier. Before enabling the amplifier emission, ensure the 
minimum input power is displayed by this register.

Figure 35  Stage one input monitor

Readings
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Readings
Pump temperature The hard-coded pump temperature of the BOOSTIK LC is displayed in Readings 
register 13. When operating, the module is designed to maintain its pump 
temperature at this value.

Figure 36  Pump temperature

Heat sink
temperature

Register 1C displays the temperature measurement from a sensor within the 
module near its rear passive cooling surface.

Figure 37  Pump 1 current
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Errors and status indicators
Errors and status indicators

For each module, click on the Error and Status tab to view the status indicators 
and if any error codes are displayed.

Status indicators  The status indicators is lit green if the condition in the text is true.

Errors If an error code is listed and cannot be cleared contact NKT Photonics support, 
see “Support contact details” on page 60.

Error codes are listed in Table 14 on page 63.

Figure 38  Error and status tab

Error code
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Graphing
Graphing

As shown in Figure 39, you can graph the values of selected parameters by 
clicking on the Graph tab and selecting the parameters you want to graph. To 
use the graphing function:

1. Select the parameters to graph from the drop-down menu at the left/right y-
axis and bottom x-axis of the graph.

2. Modify the left/right y-axis and x-axis maximum range with the input boxes.

3. Set the sample number and rate using the input boxes to the left of the graph.

Figure 39  Graphing tab

  X-axis setting

      Y-axis settings
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A   Specifications

Table 8  Optical specifications

Table 9  Power consumption

Table 10  Mechanical dimensions

Table 11  Operating and storage environment 

Table 12  Safety and regulatory compliances 

Variant: 2W @ 1550 200mW @ 1550 200 mW @ 1064

Mode of operation Continuous wave - inherently single frequency

Output power 2.0 W 200 mW 200 mW

Wavelength range 1545-1565 nm 1545-1565 nm 1060-1075 nm

Output fiber PM1550 or SMF28 PM1150 PM980

Input power 1 – 50 mW

Input/output optical termination FC/APC or E2000 (optional)

Variant: 2W 1550 200mW 1550 200mW 1064

Power Consumption [W] 20-30i

i. Subject to variant and operating conditions

5-10# 5-10#

Size (H x W x D) 92 x 220 x 39 mm (3.62 x 8.66 x 1.54 in)

Weight < 1 kg (< 2.2 lb)

Operating Temperature (internal case) 15°C to 55°C (59°F to 131°F)

Storage Temperature -20°C to 60°C (-4°F to 140°F)

Operating Humidity (non-condensing) 20 to 80%

Safety Regulatory

EN 60825-1:2014: Safety of laser products
Part 1: Equipment classification and requirements
[Laser Class 4]
EN 61010-1:2010:Safety requirements for electrical 
equipment for measurement, control, and laboratory 
use
Part 1: General requirements

EN 61326-1:2013: Electrical equipment for 
measurement, control and laboratory use
EMC requirements – Part 1: General requirements
2004/108/EC Electromagnetic Compatibility 
2011/65/EC Restriction of the use of certain Hazardous 
Substances in electrical and electronic equipment 
(RoHS) 

FDA: 21 CFR1040.10 – Performance standards for light-
emitting products
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Figure 40  Mechanical dimensions – front panel (without faceplate)

Figure 41  Mechanical dimensions – side panel

Figure 42  Mechanical dimensions – rear panel

2
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B   Service and Support Information

Servicing the laser

The laser amplifier has no user serviceable components. In case of malfunction, 
contact NKT Photonics using the support channels in section “Support contact 
details” on page 60.

CAUTION: Do not open the laser amplifier module. The module is equipped with
warranty labels (see Figure 43) that seal the covers of the module. The warranty
is void if the module is opened by removing or breaking the warranty seal.

Figure 43  Warranty seal

CAUTION: The laser amplifier contains electro-static discharge (ESD) sensitive
components. To avoid permanent ESD damage, use ESD protection precau-
tions when handling it. Always connect any earth point to a ground earth within
your facility.

Opening the module There are no user serviceable components inside the module. Should your 

laser amplifier malfunction, and it cannot be serviced, raise an RMA ticket 
request from the support site – see “Support contact details” on page 60.

WARRANTY VOID IF
REMOVED label The module is sealed with a label:

 “WARRANTY VOID IF SEAL IS BROKEN OR REMOVED”

as shown in Figure 43. It is strictly prohibited to remove the chassis cover thus 
breaking or removing the seal doing so.

WARRANTY VOID IF SEAL
IS BROKEN OR REMOVED
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Support contact details
Support contact details

If you need help or have questions regarding your Koheras BOOSTIK LC laser 
or its accessories, contact NKT Photonics through our support website below:

Support website 1. Go to:

https://www.nktphotonics.com/support

2. Scroll down and click or press:

3. Select the type of help required, fill in the form, and click or press Submit.

2
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C   Electrical interface pinout

Figure 44  C/3 electrical interface pins

Table 13  C/3 electrical interface pin descriptions

C
B
A

10      9      8      7      6      5      4      3      2      1      

30 pin DIN41612 male C/3 type

Pin # Signal Description

A1 Module OK Low: module enable low OR module power low
High: module power high

A2 RS485- Negative/inverted RS485 differential data signal

A3 Interlock loop+ Positive connection of interlock loop. Should be connected to Interlock loop- (pin no. 4) to 
enable emission from the system.

A4 Interlock loop- Negative connection of interlock loop. Should be connected to Interlock loop+ (pin no. 3) to 
enable emission from the system.

A9 N/C

A10 N/C

B1 Service NKTP Technical Support

B2 Service NKTP Technical Support

B3 Service NKTP Technical Support

B4 N/C

B9 AGND Analog ground for amplitude and wavelength modulation signals.

B10 AGND Analog ground for amplitude and wavelength modulation signals.

C1 Emission Collector output with internal 240 Ω resistor in series. The output is high when the amplifier 
emission is ON. An LED anode can be connected directly to this pin and the Cathode to GND 
to indicate emission externally.

C2 RS485 Positive/non-inverted RS485 differential data signal

C3 Enable Logic input that permits emission when a high (5V) i is applied. During emission if Enable is set 
low, emission is shut off.

C4 Enable logic input Logic input that permits emission when a high is applied. If during emission the input is set low, 
emission is shut off. This control input is for personal safety and is designed with redundancy 
within the module.

C9 N/C

C10 N/C

A5, A6, 
B5, B6, 
C5, C6

GND 0 volt / ground

A7, A8, 
B7, B8, 
C7, C8

12V 12 volt supply voltage for the module.
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D   Fault troubleshooting

If a fault occurs the laser may raise an error code. Error codes are displayed in 
the Status panel of CONTROL. Table 14 below provides a list of laser errors 
displayed and possible solutions to resolve them.

Contact support If you require further support to resolve the error, contact NKT Photonics 
support – see “Support contact details” on page 60. Ensure to include error 
codes and collected log files – see “Log downloader” on page 38.1.1

Table 14  Error codes

Code Name Description       Solution (perform in sequence)

2 Interlock Interlock circuit open or 
shorted.

1. Resolve any shorts or opens in the circuit, retry emission 
procedure.

2. Check voltage ≥ 5V at interlock pins 3 and 4 (see 
Appendix C).

3. Contact support with error code and log files.

3 Low supply voltage DC power input voltage too 
low. 

1. Check connection of the electrical cables to the modules. 
Retry emission.

2. Measure supply voltage with multi-meter. It should be 
>11.5V. Replace power supply and electrical cables.

3. Contact NKT Photonics support service for further 
recommendations. 

4 Memory problem Memory problem, EEPROM 
read/write operation failed.

1. Contact support with error code and log files.

6 Bad emission LED Emission LED circuit fault. 1. Check that the power supply and electrical cables are 
working properly.

2. Contact support with error code and log files.

7 Board temperature 
range

Control board temperature out 
of range.

1. Let the module cool down and provide proper cooling. 
Retry emission.

2. Contact support with error code and log files.

8 Module disabled The module reporting the 
error is disabled with an 
interbus hardware signal.

1. Retry emission. 
2. Check electrical connections. Retry emission.
3. Contact support with error code and log files.

12 Pump temperature 
range

Fiber pump temperature out of 
range.

1. Let the module cool down and provide proper cooling. 
Retry emission.

2. Contact support with error code and log files.

16 Sanity 1. Retry emission. 
2. Contact support with error code and log files.

48 Reflection 1. Retry emission. 
2. Contact support with error code and log files.

60 Stage 1 input power Stage 1 input optical power too 
low. 
Possible causes:
•  Seed power too low
•  Connector damaged or 

soiled.
•  Defective optics

1. Verify with fiberscope that the input connector is clean. 
Clean connectors if needed. Retry emission.

2. Check that the power of the seed exceeds 1 mW or 10 mW 
depending on the BOOSTIK LC amplifier input 
requirement.

3. The input monitor response function is dependent on 
wavelength. Try increasing the input power over the 
minimum specification. 

4. Contact support with error code and log files.
< 63 >



62 Stage 2 input 
power

Internal optical power low. 1. Contact support with error code and log files.

64 Maximum output 
power exceeded

Maximum output power 
exceeded.

1. Contact support with error code and log files.

65 Stage 1 current high Stage 1 current too high 1. Contact support with error code and log files.

66 Stage 2 current 
high

Stage 2 current too high 1. Contact support with error code and log files.

Code Name Description       Solution (perform in sequence)

2
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E   Control Software

Installing CONTROL

Download the software from:

https://www.nktphotonics.com/support

Follow the steps in Procedure .

Procedure 4  Installing CONTROL

Action

1 On the PC, launch the installer package and then click the 
Run button.

2 The installation wizard appears.

Click Next to continue.

3 Accept to use the default installation directory or select 
another directory by clicking the Browse button.

Click Next to continue.

Installer
< 65 >
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Installing CONTROL
4 Uncheck the components you do not require. By default, 
all components are installed.

Click Next to continue.

5 Read the End-User License Agreement, and check “I 
accept the license.” box.

Not checking the box ends the installation wizard.

Click Next to continue.

6 The wizard creates a start menu folder with program 
short-cuts.

Use the default name or enter a new name for the folder.

Click Next to continue.

Action

2
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7 Check the box to create a desktop shortcut to access 
Control.

Click Next to continue

8 Check the ‘Run the Silicon Labs CP10x driver installation’ 
box and click Next.

Note: USB connectivity fails if you do not install the driver.

9 Click Install to install NKTP CONTROL software on your 
PC. 

Click Cancel if you want to abort the installation.

Action
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10 The wizard displays a progress meter for the installation. 

Note: a normal install should only take a few seconds.

11 Click Next to install the UART drivers for the PC USB port. 

12 The drivers are installed. 

Note: Depending on your computer this occurs so fast 
you may not see this.

Action
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13 The Silicon Labs drivers is installed successfully.

Click Finish to end the driver installation.

14 CONTROL is now installed.

Check the Run box to launch CONTROL when the Finish 
button is clicked.

Click Finish to end the installation wizard.

Action
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